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Commands execution
Using menu and toolbar
Calling quick menu
Choosing options in dialog windows



Working with term and explanation windows
¨ Term window
¨ Explanation window
¨ Window and window groups connection
¨ Opening new term and explanation windows and closing windows
¨ Selecting languages in windows and other properties adjustment
¨ Managing window layout



Term search
¨ Term-searching methods survey
¨ Quick search
¨ Searching for a term in all languages
¨ Context term search
¨ Browsing search results



Printing and saving explanations
¨ Copying terms and explanations into Clipboard
¨ Saving an explanation
¨ Printer and printing properties set-up
¨ Printing explanations



Dictionary properties set-up
¨ Adjusting interface properties
¨ Selecting fonts
¨ Adjusting search properties



Technical support

In case if any questions on Dictionary usage occur or if there are some notes and offers, you 
can contact GARANT-SERVICE.

Moscow office phones:
939-08-50, 939-16-05,
939-08-04, 939-18-88.

Faxes: 938-28-73, 939-00-71.
Address: GARANT-SERVICE, Moscow S. University, Leninsky Gory, 

119899 Moscow.



Hot keys

Key combinations that allow to carry out the most convenient Dictionary commands are 
listed below.

F1 reference guide context-dependant call
Shift+F1 allows to obtain a tip on Dictionary screen elementsand menu 

items
F3 passing over to the next term, containing the set context

Shift+F3 passing over to the previous term, containing the set context
Shift+F4 arrange open windows in the tiled order
Ctrl+F4 close current window 
Alt+F4 close current dialog window or exit Dictionary

Shift+F5 arrange open windows in the classical scheme
F7 

Ctrl+F
searching for a term in all languages

Shift+F7 context term search
Alt+F10 call quick menu
Ctrl+Ins
Ctrl+C

copying current explanation into Clipboard

Shift+Ins
Ctrl+V

translating a term or an explanation out of the Clipboard

Ctrl+A turning on automatical window arranging using the chosen 
scheme

Ctrl+R browsing search results
Ctrl+P printing current explanation on printer

Ctrl+Alt+P quick printing using current printer and printing properties
Ctrl+S saving current explanation into a text file

Alt+Enter set-up window properties





Main menu commands

         File  
          Save as...  
          Print  
          Print Setup...  
          Exit  
          Edit  
          Search  
          References  
          Options  
          Window  
          Help  



Main menu commands

          File  
         Edit  
          Copy  
          Search  
          References  
          Options  
          Window  
          Help  



Main menu commands

          File  
          Edit  
         Search  
          Search for term  
          Search by Clipboard  
          Search for context  
          Next  
          Previous  
          Search results  
          References  
          Options  
          Window  
          Help  



Main menu commands
          File  
          Edit  
          Search  
         References  
          Forward  
          Back  
          Go To...  
          Term list  
          Options  
          Window  
          Help  



Main menu commands
          File  
          Edit  
          Search  
          References  
         Options  
          Window properties  
          Preferences...  
          Always on top  
          Window  
          Help  



Main menu commands
          File  
          Edit  
          Search  
          References  
          Options  
         Window  
          New term window  
          New explanation window  
          Close  
          Tile  
          Classic  
          Arrange icons...  
          Arrange...  
          Open windows list  
          Help  



Main menu commands
          File  
          Edit  
          Search  
          References  
          Options  
          Window  
         Help  
          Contents  
          Search for help on  
          Trouble shooter  
          Tip of the day  
          Literature  
          About Dictionary  



Main menu commands
          File  
          Edit  
          Search  
          References  
          Options  
          Window  
          Help  



 Main menu commands

         File  
          Save as...  
          Print  
          Print Setup...  
          Exit  
         Edit  
          Copy  
         Search  
          Search for term  
          Search by Clipboard  
          Search for context  
          Next  
          Previous  
          Search results  
         References  
          Forward  
          Back  
          Go To...  
          Term list  
          Options  
          Window properties  
          Preferences...  
          Always on top  
          Window  
          New term window  
          New explanation window  
          Close  
          Tile  
          Classic  
          Arrange icons...  
          Arrange...  
          Open windows list  
          Help  
          Contents  
          Search  
          Trouble shooter  
          Tip of the day  
          Literature  
          About Dictionary  



Save as... command (File menu)
see also

Use this item to save current explanation text into a file as DOS or Windows text.
main toolbar button saves explanations into a file.



Saving an explanation



Print command (File menu)
see also

Use this item to print current explanation on a printer. You can set printer type, paper size, 
margins and other properties.

Notice. Use  main toolbar button to print an explanation quickly. Current printer and 
printing properties will be used.



Printing explanations
Printer and printing properties set-up



Print Setup... command (File menu)
see also

Use this item to set printer and printing properties. You can set printer type, paper size, 
margins etc.
Notice. You can also enter or change these properties by pressing Properties button in 
Explanation printing dialog window.



Printer and printing properties set-up
Printing setup dialog window - Printer folder
Printing setup dialog window - Margins folder



Exit Command (File menu)
Use this item to finish working with Dictionary.



Copy command (Edit menu)
see also

Use this item to copy current explanation (when an explanation window is active) or current 
term (when a term window is active) into Clipboard.

main toolbar button copies explanations or terms into Clipboard

Copying explanations into Clipboard



Search for term command (Search menu)
see also

Use this item to perform term search in all languages, maintained by Dictionary.
main toolbar button starts term search

Term search in all languages
Term-searching methods survey



Search by Clipboard command (Search menu) 
see also

Use this item to translate a term, formerly put into Clipboard.
main toolbar button translates a term, contained by Clipboard

Term search in all languages



Search for context command (Search menu)
see also

Use this item to find terms in the active window that contain a set letter sequence (context).
main toolbar button starts context term search

Context term search
Term-searching methods survey



Next command (Search menu)
see also

Use this item to find the next term that contains context. Search is performed forward 
(down) from the current term. If a term is found, marker is automatically set on it.

main toolbar button moves marker to the next term that contains 
context.

Term-searching methods survey
Context term search



Previous command (Search menu)
see also

Use this item to find the previous term that contains context. Search is performed backward 
(up) from the current term. If a term is found, marker is automatically set on it.

main toolbar button moves marker to the previous term that contains 
context

Term-searching methods survey
Context term search



Search results command (Search menu)
see also

Use this item to open a window containing search results list.
main toolbar button allows to browse search results

Browsing search results
Term-searching methods survey



Forward command (References menu)
see also

Use this item to pass over to the next term in references jumps list.
main toolbar performs a jump to the next term

Explanation window



Back command (References menu)
see also

Use this item to pass over to the previous term in references jumps list.
main toolbar performs a jump to the previous term

Explanation window



Go To... command (References menu)
see also

Use this item to browse a list of terms youve jumped to using references. You can move over
to an explanation of a term youve selected out of the list.

main toolbar allows to browse a list of terms youve jumped over to using 
references

Notice. You can pass over to the lately called explanations by selecting a term out of the list 
in References menu.



Explanation window



Term list (References menu)
see also

To pass over to one of the nine last explanations youve called using references, select a term
name out of the list in References menu.
Notice. To get a list of all terms youve jumped to on references use Go To... item in 
References menu.



Explanation window



Window properties command (Options menu)
see also

Use this item to set current window preferences: language, font, alignment.
main toolbar button is for window preferences adjustment

Notice. You can change certain preferences quickly if you use current window toolbar.



Selecting languages in windows and other properties adjustment
Term window toolbar
Explanation window toolbar



Always on top command (Options menu)
Select this item to make Dictionary be always above all the other programs windows. This 
may be convenient if you often turn over to Dictionary while working with other programs.
To cancel Always on top mode, select this item one more time.



Preferences... command (Options menu)
see also

Use this item to adjust Dictionary properties: messages and menu language, applied fonts, 
searching properties etc.



Adjusting interface properties
Selecting applied fonts
Adjusting search properties



New term window command (Window menu)
see also

Use this item to open a new term window.
main toolbar opens new term windows

Notice. If you keep Shift key pressed while selecting this item, the newly opened window 
wont be linked with formerly opened.



Term window
Windows and window group connection
Opening new term and explanation windows and closing windows



New explanation window command (Window menu)
see also

Use this item to open a new explanation window.
main toolbar opens new explanation windows

Notice. If you keep Shift key pressed while selecting this item, the newly opened window 
wont be linked with formerly opened.



Explanation window
Windows and window group connection
Opening new term and explanation windows and closing windows



Close command (Window menu)
see also

Use this item to close the current window.
Notice. To close a window quickly double-click in the upper left window corner.



Opening new term and explanation windows and closing windows



Tile command (Window menu)
see also

Use this item to arrange open windows so that the whole of them could be seen.



Managing window layout



Classic command (Window menu)
see also

Use this item to arrange the open term windows at the top in horizontal tile, and explanation
windows below in vertical tile (the same way its done in Business&Law Dictionary for DOS).



Managing window layout



Arrange... command (Window menu)
see also

Use this item to select an arrangement scheme for term and explanation windows.

main toolbar turns on/off window automatical arrangement in accordance
with the selected scheme.

Notice. You can quickly arrange windows in accordance with the classic scheme or in the 
tiled order if you select a corresponding item in Window menu.



Managing window layout
Window arrangement dialog window



Arrange icons... command (Window menu)
Use this item to arrange folded windows icons into a row along the lower edge of Dictionary 
window.



Open windows list (Window menu)
see also

To pass over to one of the open windows, select a window name out of the list in Window 
menu.
Notice. If youve marked Hide search windows item in Search preferences, the list will 
contain no folded search results windows. To open a search results window, use Search 
results item in Search menu.



Opening new term and explanation windows and closing windows
Managing window layout



Contents command (Help menu)
see also

Use this item to call Dictionary reference guide.



Reference guide call
Quick tip on toolbar buttons and menu items
Tip on Dictionary screen elements



Search command (Help menu)
see also

Use this item to find information on determined subjects in Dictionary reference guide.



Quick tip on toolbar buttons and menu items
Tip on Dictionary screen elements



Trouble shooter command (Help menu)
Use this item to call reference guide section describing various problems and possible ways 
to their extinction.



Tip of the day command (Help menu)
see also

Use this item to browse tips on Dictionary usage.



Tip of the day



Literature command (Help menu)
Use this item to browse list of literature that was used during Dictionary elaboration.



About Dictionary command (Help menu)
see also

Use this item to look through a brief reference on Dictionary.



Technical support
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Language command (Term window menu)
see also

Use this item to select a language in the current window.
Notice. You can change current language quickly if you use current window toolbar.



Selecting languages in windows and other properties adjustment



Font command (Term window menu)
see also

Use this item to change font in the current window.
Notice. For Russian and European letters correct display different fonts should be used. 
Therefore, if you change language in a window, terms may be displayed incorrectly.



Selecting languages in windows and other properties adjustment
Selecting applied fonts



Search for term command (Term window menu)
see also

Use this item to carry out Term search in all languages, maintained by Dictionary.
main toolbar button starts term search.

Term-searching methods survey



Search for context command (Term window menu)
see also

Use this item to find terms containing a set letter sequence (context).
main toolbar button starts context term search.

Term-searching methods survey



Next occurance command (Term window menu)
see also

Use this item to find the next term containing the set context. Search is performed forward 
(down) from the current term. If a terms found, marker is automatically set on it.

main toolbar button performs a jump on the next term containing 
context.

Term-searching methods survey



Search results command (Term window menu)
see also

Use this item to open a window containing Search results list.
main toolbar allows to look through search results.

Term-searching methods survey
Term search in all languages
Context term search



Copy command (Term window menu)
see also

Use this item to copy the current term into Clipboard.
main toolbar copies the current term into Clipboard

Copying explanations into Clipboard



Language command (Explanation window menu)
see also

Use this item to select language and alignment type in the current window.
Notice. You can change applied language and alignment type quickly by using current 
window toolbar.



Selecting languages in windows and other properties adjustment



Font command (Explanation window menu)
see also

Use this item to select font in the current window.
Notice. For Russian and European letters correct display different fonts should be used. 
Therefore, if you change language in a window, terms may be displayed incorrectly.



Selecting languages in windows and other properties adjustment
Selecting applied fonts



Go To... (Explanation window menu)
see also

Use this item to jump on to the quoted term using a reference.

Notice. This menu item appears if you click with the right mouse button upon a reference in 
an explanation.



Explanation window



Back command (Explanation window menu)
see also

Use this item to pass over to the previous term out of the reference jumps list.
main toolbar causes a jump to the previous term.

Explanation window



Jump on command (Explanation window menu)
see also

Use this item to look through a list of terms youve jumped on using references. 
You can go to a term explanation by selecting the term out of the list.

main toolbar allows to look through a list of terms youve jumped on using
references.

Explanation window



Search results command (Explanation window menu)
see also

Use this item to open a window containing search results.
main toolbar allows to browse search results.

Term-searching methods survey
Term search in all languages
Context term search



Copy command (Explanation window menu)
see also

Use this item to copy the current explanation into Clipboard.
main toolbar copies the current explanation into Clipboard

Copying explanations into Clipboard



Print command (Explanation window menu)
see also

Use this item to print the current explanation on a printer. Current printer and printing 
properties will be used.
Notice. To print explanations quickly use  main toolbar button.



Printing explanations
Printer and printing properties set-up



Toolbar command (Desktop menu)
see also

Use this item to turn off main toolbar display.
To turn main toolbar display on, perform the command again.



Toolbars
Adjusting interface properties



Status bar command (Desktop menu)
see also

Use this item to turn off status bar display.
To turn status bar display on, perform the command again.



Adjusting interface properties



Preferences... command (Desktop menu)
see also

Use this item to adjust Dictionary properties: messages and menu language, applied fonts, 
search properties etc.



Adjusting interface properties
Selecting applied fonts
Adjusting search properties



Search for term command (Search results window menu)
see also

Use this item to perform Term search in all languages, maintained by Dictionary.
 main toolbar. performs term search.



Term-searching methods survey



Search results command (Search results window menu)
see also

Use this item to open a window containing search results.
 main toolbar allows to browse search results.



Term-searching methods survey
Term search in all languages
Context term search



Minimize command (Search results window menu)
see also

Use this item to minimize a window containing search results. You can open the window later
by selecting Search results item in Search menu.



Browsing search results
Search results survey dialog window



Close command (Search results window menu)
see also

Use this item to close a window containing search results. Search results will be removed.



Browsing search results
Search results survey dialog window





Menu bar
see also

Menu is a bar in the upper part of Dictionary window. To open menu, place mouse marker on 
the required section title in the menu bar and press the left button. After that you can select 
the required menu item using mouse. In this manner you can execute any system 
commands that are available at the moment. Menu item selection is carried out either by 
mouse or by pressing Alt and the key thats underlined in the menu item title.



Main menu commands



Toolbars
see also

Toolbar is a set of buttons allowing to execute quickly different commands: change language
in windows, print an explanation, search for term etc. There are one main toolbar (its 
situated in the upper part of Dictionary window) and toolbars in any of the term and 
explanation windows.

To press a button (i.e. execute the corresponding function), click left mouse button on it.
Notice. Some toolbar buttons are not always available. These buttons are painted grey and 
cannot be pressed. E.g., the button of the return to the previous explanation is not available 
if you havent jumped on to another term using a hypertext reference yet.
You can turn off main toolbar in Dictionary interface properties adjustment dialog window.



Main toolbar
Term window toolbar
Explanation window toolbar
Quick tip on toolbar buttons and menu items
Tip on Dictionary screen elements



Scrollbars
Scrollbars can be situated along the right and lower window borders. When the whole of 
some information cant be housed in a window (e.g. lengthy explanations or term lists), 
scrollbars allow to browse it by scrolling text. 
Scrollbars contain thumbs showing what text or list part is currently situated in the window.
To scroll text
¨ press an arrow in the beginning or in the end of the scrollbar
¨ drag marker into the required position with mouse.



Status bar
see also

Status bar is situated in the lower most part of Dictionary window. It displays tips on toolbar 
buttons, menu item functions and information on Dictionary state.
You can turn off status bar in Dictionary interface properties adjustment dialog window.



Quick tip on toolbar buttons and menu items



Using menu and toolbar
For Dictionary commands execution



Calling reference guide
see also

You can obtain help (tip) any moment you need it.
1. To turn over to reference guide:

¨ select Contents item in References menu.
Reference guide table of contents will appear.

2. To obtain help in a dialog window  (e.g. in term search and explanation 
printing dialogs etc.):

¨ press HELP button.
Youll pass over directly to the reference guide section describing the current 
dialog.

3. You can also turn over to reference guide by pressing F1.

main toolbar    button calls reference guide table of contents



Quick tip on toolbar buttons and menu items
Tip on Dictionary screen elements



Quick tip on toolbar buttons and menu items
see also

You can get quick tips on toolbar buttons and menu items destination.
To obtain quick tip on a toolbar button:

¨ place mouse marker on it and wait for about a second.
Button description and a hot key combination will appear in the status bar and 
near the button.

Status bar gives a brief description of the menu item, where marker points.



Tip on Dictionary screen elements
Reference guide call



Tip on Dictionary screen elements
see also

You can obtain help on Dictionary screen elements by pointing at them with 
mouse. To do so:

1. Press  main toolbar button. Mouse marker will look like a question-mark.
2. Click on the required Dictionary screen element: toolbar button, status bar, menu

item etc. 
Youll get directly to the reference guide section describing the chosen screen 
element.



Quick tip on toolbar buttons and menu items
Reference guide call



Term window
see also Language Scrolling Marker position

Term window contains an alphabetically ordered list of terms that are included in 
Dictionary, and marker that moves through the list.

You can choose one of Dictionary languages in the window. Window title contains the chosen
language name, e.g. RUSSIAN. If not all the open windows are connected, the name will be 
prefixed with a group number.
You can move marker through list in different ways:
¨ using keys , ;
¨ with mouse (using scrollbar);
¨ by moving marker through the list while you keep the left button pressed (to scroll 

information in window, move marker over the lower or the upper border of the window 
frame).

You can also input first term letters. An input window will appear and marker will be pointing 
out a term beginning with the input letters. When marker is placed on the required term, 
press Enter.
You can lock marker position in the window. If you do so, marker will stay at its place and 
term list will be scrolled in the window when you move through terms. If marker position is 
not locked, term list will be scrolled only when marker reaches the upper or the lower most 
line in the window.
To fix marker position:
¨ use ScrollLock button
or

¨ press  button on current window toolbar. 
Repeated pressure cancelles the mode.



Selecting laguages in windows and other properties adjustment
Opening new term and explanation windows and closing windows
Windows and window groups connection



Explanation window
see also Languages Scrolling    References

Explanation window contains explanation of the chosen term (That very term which is 
marked out in the connected term window).

You can select Russian or English language in the window; term name in the chosen 
language is displayed in the window title, e.g. Leasing. If not all the open windows are 
connected, names will be prefixed with with group number.
If the whole of an explanation cannot be housed in the window, you can scroll text in the 
window. That can be done in the following ways: 
¨ using keys , ;
¨ with mouse (using scrollbar);
¨ by moving marker through the list while you keep the left button pressed (to scroll 

information in window, move marker over the lower or the upper border of the window 
frame).

For easening explanations study, explanations are supplied with hypertext references - 
words and word combinations, underlined and marked out with colour. Due to that you can 
immediately specify the meaning of a term youve run across in an explanation
Explanation windows may contain marker moving over references. The marked out 
reference is outlined with colour. To move marker Tab key is used.
You can jump on a reference in the following ways:
¨ place marker on a reference and press Enter;
¨ click on a reference.
Explanation of the term youve passed over to using a reference will be put in the current 
window.
You can also place term explanation into a new window, not connected with others. To do so:
¨ place marker on a reference and press Shift+Enter or
¨ click on a reference, keeping Shift key pressed.
Dictionary memorizes terms youve browsed using references. You can:
¨ return to the previous explanation; to do that select Backward item in References 

menu.
¨ move over to the next browsed explanation; to do that select Forward item in 

References menu.
¨ quickly pass to any of the explanations youve browsed; to do so, select Go to… item in 

References menu, select a term out of the proposed list and press OK button.
Notice: to move over to term explanations youve browsed using references, you can use 
main toolbar buttons.
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Window and window group connection
see also

Working with Dictionary, you can open several window groups, each containing one or 
several term and explanation windows.
Group name is displayed right before window names, e.g. Group 1:Leasing. If all open 
windows are connected, group name is not displayed.
All windows in a group are connected. That means, when marker is moved through term list, 
markers in all the linked term windows will be set on the chosen terms translation, and its 
explanation will appear in explanation windows.
Window connection is not always convenient, though. Therefore you can open a new window
group.
To open a new term or explanation window, not linked with formerly opened, you:
¨ select New term window item in Window menu, keeping Shift key pressed.
¨ when jumping on a reference in an explanation, keep Shift key pressed; referenced term 

explanation will be put into a new window, not linked with formerly opened.
In other cases newly opened windows are added to the current group (i.e. they are 
connected with the current window).

main toolbar button opens new term window
main toolbar button opens new explanation window 



Term window
Explanation window
Opening new term and explanation windows and closing windows



Opening new term and explanation windows and 
closing windows
see also

This section describes new windows, linked with the current one opening methods. To open 
windows, not linked with the current one, see Windows and window groups connection.

 To open a new term window:
¨ select New term window item in Window  menu.
To open a new explanation window:
¨ select New explanation window item in Window  menu;
or

¨ double-click on the required term, its explanation will be put into a new window.
To close current term or explanation window:
¨ select Close item in Window  menu;
or

¨ double-click in the upper left window corner.

main toolbar button opens a new term window
main toolbar button opens a new explanation window



Term window
Explanation window



Selecting languages in windows and other properties 
adjustment
see also Language Font Alignment

You can select one of the languages, maintained by Dictionary in any term or explanation 
window.
For term windows languages are: Russian, English, German, Spanish, French or Italian,
for explanation windows - Russian or English.
To select a language in a window:
1. select Window properties item in Options menu and turn over to Text folder. Windows 

properties set-up dialog appears.
2. Set language in the corresponding field and press OK.

To change language quickly, use current window toolbar buttons.
You can set text alignment method in explanation windows: left, right, center or justified.
To set alignment method in an explanation window:
1. Select Window properties item in Options menu and turn over to Text folder. Window 

properties set-up dialog appears.
2. Set alignment type in the corresponding field and press OK.

To change alignment method quickly, use current window toolbar buttons.
You can change font being used for term and explanation display in the window. Window 
fonts are set by default: two fonts, set in Dictionary preferences, are used for Russian and 
European letters display.
Notice. You need different fonts for Russian and other languages correct display. Therefore, 
terms (explanations) may be displayed incorrectly if you change a font and then change 
window language.
To change window font:
1. Select Window properties item in Options menu and turn over to Text folder. A dialog 

window appears.
2. Mark Use specified font field.
3. Set font, its style and size;
4. If you want the chosen font be applied in all open windows, mark in Apply to all 

windows field.
Attention! If you want to work with Russian and European languages simultaneously, 
do not mark in this field.

5. Press OK.
To set font automatical selection mode in a window:
1. Select Window properties item in Options menu and turn over to  Font folder. A dialog

window appears.
2. Mark in Select font automatically field.
3. If you want the chosen font be applied in all open windows, mark in Apply to all 

windows field.
4. Press OK.



Term window
Explanation window



Managing window layout
see also

You can arrange term and explanation windows in a definite scheme.
To arrange windows you:
1. Select Arrange item in Window menu. A dialog window appears.
2. Select a window arrangement scheme out of the list. You can see the way presently open 

windows will be arranged in the right window
3. Mark if windows should be automatically arranged when opened or closed.

main toolbar button turns on/off window automatical arrangement in the 
chosen scheme.

Notice. You can quickly arrange windows in the classical scheme or in the tiled order if you 
select a corresponding item in Options menu.



Window layout dialog window
Selecting laguages in windows and other properties adjustment
Term window
Explanation window



Term-searching methods survey
Dictionary is provided with powerful document-searching methods. These are:
1. Quick search - allows to set marker on a term in the current term window by just inputting

its beginning letters;
2. Term search in all languages - allows to carry out term search in all languages, maintained

by Dictionary;
3. Context term search - allows to find terms containing a set letter sequence (context) in 

one language bounds.



Quick search
see also

This searching method allows to set marker on a term in the current term window by just 
inputting its beginning letters.
To do so:
1. Start inputting the beginning letters of the term you want to pass over to. Its not 

necessary to switch keyboard to the apportionment of the language chosen in the term 
window - Dictionary does it automatically;

2. A quick search window, containing letters youre typing will appear. Marker in the term 
window will be automatically set on a term with the coinciding beginning letters.

3. When marker is set on the required term, press Enter. Quick search window disappears 
and marker is set on the chosen term. If you wish to return to the term that was chosen 
before search start, press Esc.

Notice. If letters can not be entered, theres no term with the coinciding beginning letters in 
Dictionary.



Term window
Term-searching methods survey



Term search in all languages
see also

This searching method allows to carry out term search in all languages, maintained by 
Dictionary
To carry out term search in all languages you:
1. Call term searching dialog: select Search for term item in Search menu
2. Set term you want to find and press OK. You can also insert a term from Clipboard by 

pressing Shift+Ins.
3. Term search in all languages, maintained by Dictionary, will begin.
4. After search was accomplished a list of all found terms will be built.

main toolbar button starts term search

Notice. You can perform search of terms that were situated into Clipboard by selecting 
Search by Clipboard item in Search menu.

main toolbar button translates a term taken from Clipboard



Term-searching methods survey
Term window



Context term search
see also

This searching method allows to find terms containing a set letter sequence (context) in one 
language bounds. Context search, unlike Term search in all languages, is performed in the 
active term window only.
To carry out context term search you:
1. Select Search for context  item in Search  menu. Context search dialog will appear.
2. Set the term you wish to find in Context field. You can also insert a term from Clipboard 

by pressing Shift+Ins;
¨ Indicate if the set context is the beginning of a word in Only from the beginning of 

a word field.
3. After youve set context and searching properties, press

¨ Find All - to find all terms containing the set context. Search results list will be built 
after the searchs end;

or
¨ Next - to find the first present term and place marker on it. Search is performed down 

from the current term on to the list end.
Further on you can:
¨ Find alphabetically next term by selecting Next item in Search menu.
¨ Find previous term by selecting Previous item in Search menu.

main toolbar button starts context term search
main toolbar button is for passing over to the next term that contains 
context
main toolbar button is for passing over to the previous term that contains
context



Term-searching methods survey
Term window



Browsing search results
see also

When term search in all languages or context search are accomplished, search results are 
automatically displayed.
List of all found terms is displayed in search results window.
You can pass over to any term of the list by double-clicking the term title.
If you wish to save search results, fold the window by pressing Minimize button.
Further on you can browse saved search results:
1. Select Search results item in Search menu.
2. Select a term or a context whose search results you want to see from results list.
Folded windows with search results will be displayed as icons in the lower most part of 
Dictionary screen, if only Hide search windows item in search preferences is not marked. 
You can open a folded window by double-clicking on it.

To remove search results, close results window by pressing Close button.

main toolbar button is for browsing search results



Term-searching methods survey
Term search in all languages
Context term search



Copying terms and explanations into Clipboard
You can copy a term or an explanation into Clipboard, and then insert into some other 
program.
To copy a term or an explanation into Clipboard you:
1. Switch to the required term or explanation window.
2. Select Copy item in Edit menu.

Then execute Paste command in the program you want to move explanation text to.

main toolbar button is for copying terms and explanations into Clipboard



Saving an explanation



Saving an explanation
see also

You can save explanations to a file. Further on youll be able to work with saved explanations 
using other programs, e.g. text editors. Text can be saved in one of the following 
formates:DOS text, DOS text with line breaks, and Windows text.
To save an explanation to a file:
1. Switch to the explanation window that contains text you want to save to a file.
2. Select Save item in File menu. A dialog window will appear.
3. Choose disk and directory for the file and input file name.
4. Select file format in Save in format field.
5. Press OK to save explanation to a file.

main toolbar button is for saving explanations to a file.

Notice. You can quickly move an explanation text to another Windows program by copying 
the explanation into Clipboard. Then you perform Paste command in the program you want 
to move explanation text to.



Copying explanation to Clipboard



File Formats
Dictionary can save explanations to a file in one of the following formats:

DOS text Text is saved as a DOS 
page, while Russian letters 
are saved in alternate 
encoding. Line break 
symbol is placed at 
paragraph end.

Windows text Text is saved as a Windows
page. This format is 
understood by any 
Windows editor.

DOS text 
w/line breaks

Text is saved as a DOS 
page, while Russian letters 
are saved in alternate 
encoding. Line break 
symbol is placed at the 
end of each line.

Printer and printing properties set-up
see also

You should set printer and printing properties before printing an explanation.
To set printer and printing properties you:
1. Select Print setup item in File menu. A dialog window will appear.
2. Select printer type, paper size and orientation in Printer folder.
3. Set margins in Margins folder. Notice, that margins are set in units that are specified

in the corresponding field.

Notice. You can also set these properties right before you start printing explanations by 
pressing Options button in printing dialog.



Printing explanations
Printing preferences dialog window - Printer folder
Printing preferences dialog window - Margins folder



Printing explanations
see also

You can print an explanation on printer.
To print an explanation on printer:
1. Switch over to the explanation window that contains text you want to print.
2. Select Print item in File menu. A dialog window will appear.
3. Select printer type, applied paper size and orientation.
4. Adjust printer and printing properties (use Properties button) when necessary.
5. Press OK to print explanations.

Notice. Use  main tollbar button to print an explanation quickly. Current printer and 
printing parameters will be used.



Printer and printing properties set-up
Printing explanation on printer dialog window



Adjusting interface properties
see also

You can select a language for messages and menus, hide certain screen elements, turn 
quick tips on toolbar buttons on/off, etc.

To set-up interface properties:
1. Select Preferences item in Options menu. Dictionary preferences set-up dialog window 

will appear.
2. Switch over to Interface folder.
3. Select a language (Russian or English) for menu items,various messages and reference 

guide display.
4. Point out if 

main tollbar,
status bar,
quick tips on toolbar buttons
Tip of the day on Dictionary startup should be displayed.

5. Press OK to confirm changes in interface properties set-up.



Dictionary preferences dialog window - Interface folder



Adjusting search properties
see also

You can adjust some term-searching properties - e.g. mark out if icons of the folded search 
results windows should be displayed etc.

To adjust search properties you:
1. Select Preferences item in Options menu. Dictionary preferences set-up dialog window 

will appear.
2. Switch over to Search folder.
3. Set the search properties.
4. Press OK button to confirm changes in search properties set-up.

Notice. Properties changing wont affect searches already in progress.



Dictionary preferences dialog window - Search folder
Term-searching methods survey



Selecting applied fonts
see also

Dictionary uses two different fonts for Russian and European letters display.

To select fonts:
1. Select Preferences item in Options menu. Dictionary preferences set-up dialog window 

will appear.
2. Switch over to Font folder.
3. Select a russified font in Russian field. In the frame on the right you can see the word 

Russian displayed in the selected font.
4. Select a font in European field (the font should not be russified). In the frame on the 

right you can see European languages names displayed in the selected font. Get sure that
all the letters are displayed correctly.

5. Press OK to confirm font changes.

Notice. You can also change font in a determined window (see Selecting languages in 
windows and other properties set-up), but automatical font selection mode wont be applied 
in this case.



Dictionary preferences dialog window - Search folder





Database opening dialog window
Set the database you want Dictionary to work with. Base file is called bus&law.dic and is 
situated in the directory chosen during Dictionary DOS version installation.

File name
Set a name for the file where Dictionary base is situated.

Disks
Set a disk where Dictionary base is situated.

Directories
Set a directory where Dictionary base is situated. Thats the directory youve installed 
Dictionary DOS version in.

OK button
Press this button to confirm Dictionary database selection. This base will be used during 
further Dictionary starts.

Cancel button
Press the button to cancel Dictionary database selection.

Help button
Calls the current reference guide page.



Explanation saving dialog window
also see
You can set a name and format for the file where explanations will be saved to.

It allows to save an explanation to a text file.

File name
Set a name for the file where explanation will be saved to. File name is entered directly from 
keyboard in accordance with DOS operating system requirements. You can use Russian 
letters in file name only if you use a russified DOS version.

Disks
Select a disk where file will be saved to.

Directories
Select a directory where file will be saved to..

Save in format
Set a format for text being saved into file.

OK button
Press the button to save explanation to the set file.

Cancel button
Press the button to cancel explanation saving to the set file.

Help button
Calls the current reference guide page.



Saving an explanation



Explanation printing dialog window
also see
It allows to print explanations on a printer.

Printer
This line displays the name of printer that will perform printing. You can select another 
printer (press Setup button).

Copies:
Set the number of copies you want to print.

Collate copies
Mark this item if while printing several copies you want all pages of a copie be printed first, 
then the whole of the next copy and so on. If this item is not marked, all the first pages will 
be printed first, then all the second pages and so on.

Quality
Select resolution that will be taken while printing (the greater this value is, the better is the 
quality).

Print to file
Mark this item if you want printing be carried out to file. Thats convenient if printer is 
attached to another computer (you can copy the resulting file and print it on another 
computer with "copy /b <èìÿ ôàéëà> LPTn" command, where n is the number of the port, 
connected with printer).

OK button
Press the button to start printing explanations. Formerly set printer and paper type and 
margins will be used.

Cancel button
Press the button to cancel printing explanations.

Setup button
It allows to set printer, where printing will be carried out, and applied paper type.

Help button
Calls the current reference guide page.



Printing explanations
Printer and printing properties set-up



Printing preferences dialog window - Printer folder
also see
You can set paper size and printer type for explanations printing.

Printer
Set printer youd like to print explanations on. List contains printers that are set in Windows. 
If you wish to set a new printer, consult Windows documentation.

Page size
Select the type of paper that will be applied for printing.

Height
Set page height if youve selected a user defined paper type.

Width
Set page width if youve selected a user defined paper type.

Measure units
Set measure units - millimeters (mm), centimeters (cm) or inches (inch).

Orientation
Select paper orientation - Portrait or Landscape.

Sample
In this window you can see the way explanation text will be placed on a page.

OK button
Press the button to confirm printer, paper size and margins selection.

Cancel button
Press the button to cancel printer, paper size and margins selection.

Options button
Press the button to set extra printer options.

Help button
Calls the current reference guide page.



Printer and printing properties set-up
Printing explanations



Printing preferences dialog window - Margins folder 
also see
You can set margins for printing explanations on printer.

Size
Indicate the selected paper size. You can select another paper size, when you switch over to 
Printer folder.

Left margin
Indicate left margin value.

Right margin
Indicate right margin value.

Top margin
Indicate top margin value.

Bottom margin
Indicate bottom margin value.

Notice. Margins cant be set at less than some determined values. Minimal margin values 
depend on applied printer type.

Measure units
Set measure units - millimeters (mm), centimeters (cm) or inches (inch).

Sample
In this window you can see the way explanation text will be placed on a page.

OK button
Press the button to confirm printer, paper size and margins selection.

Cancel button
Press the button to cancel printer, paper size and margins selection.

Options button
Press the button to set extra printer options.

Help button
Calls the current reference guide page.



Printer and printing properties set-up
Printing explanations



Term search dialog window
also see

You can set a term for search in all languages, maintained by Dictionary.

Term
Set a term or its first letters. All terms beginning with the entered letters will be found as a 
search result.

OK button
Press this button to start term search. When search ends, a list of all found terms is built.

Cancel button
Press this button to cancel term search.

Help button
Calls the current reference guide page.



Term search in all languages



Context search dialog window 
also see

You can set a context for search in between terms of the current language.

Context
Set context - a letter sequence that should be contained by the required term.

Only from the beginning of a word
Mark this field to find only those terms where context is the beginning of a word.

Next button
Press this button to find a term containing the set context. Search is started at the current 
term. When search ends, marker is set on the found term. Further on you can find next 
(previous) context entry by selecting a corresponding item in Search menu.
Find All button
Press this button to find all terms containing the set context. When search ends a list of all 
found terms is built.
Cancel button
Press this button to cancel context search.

Help button
Calls the current reference guide page.



Context term search



Window properties dialog window - Font folder
also see
You can change font used for terms and explanations display.

Window
Select one of the listed term and explanation windows.

Indicate if font should be selected automatically when language in the window is changed: 
Dictionary uses two different fonts for Russian and European letters display.

Font
Select one of the listed fonts to be used in the selected window.

Style
Set a style for the selected font (bold, italic etc.).

Size
Set letter size. For TrueType fonts (these font names are marked out with  sign). You can 
enter font size directly from keyboard.

Sample window
You can see text displayed with the chosen font.

Apply to all windows
Mark this item to apply the chosen font to all windows.

Attention! If you want to work with Russian and European languages simultaneously, 
mark this item only if youve set font automatical selection mode.

OK button
Press this button after youve selected font, language and alignment type.

Cancel button
Press this button to cancel font and language selection. Formerly set font and language will 
be used.

Help button
Calls the current reference guide page.

Auto Fonts button
Press this button to set fonts, used for Russian and European languages letters display by 
default.



Selecting languages in windows and other properties adjustment
Term window
Explanation window
Selecting applied fonts



Window properties dialog window - Text folder 
also see
You can set language and alignment type for term and explanation windows.

Window
Select one of the listed term and explanation windows.

Language
Select a language to be used in the window.

Alignment
You can set how explanations text should be aligned in explanation windows.

Sample window
You can see how text will be displayed in the selected window.

OK button
Press this button after youve selected font, language and alignment type.

Cancel button
Press this button to cancel font and language selection. Formerly set font and language will 
be used.

Help button
Calls the current reference guide page.



Selecting languages in windows and other properties adjustment
Term window
Explanation window



Dictionary preferences dialog window - Interface folder
also see
It allows to adjust Dictionary interface preferences.

Language
Select a language (Russian or English) for menu items, various messages and reference 
guide.

Toolbar
If this item is marked, main toolbar is displayed on the screen.

Status bar
If this item is marked, Status bar is displayed on the screen.

Tool-tips
Mark this item to turn on quick tips on toolbar buttons.

Hot keys in tool-tips
If the field is marked, quick tips on toolbar buttons will contain hot key combinations 
corresponding with the button purpose.

Show tips on startup
If this field is marked, Tip of the day will be displayed on startup.

OK button
Press the button after youve adjusted Dictionary preferences.
Cancel button
Press the button to cancel changes in Dictionary preferences.

Help button
Calls the current reference guide page.



Adjusting interface properties



Dictionary preferences dialog window - Search folder
also see
It allows to change term-searching properties.

Use animation
If this field is marked, a picture of pages turned over will be displayed during term search.

Hide search windows
If this field is marked, no folded search results window icons will be displayed.

OK button
Press the button after youve adjusted search properties.
Cancel button
Press the button to cancel changes in search properties.

Help button
Calls the current reference guide page.



Adjusting search properties
Term-searching methods survey



Dictionary preferences dialog window - Fonts folder
also see
It allows to select fonts used by default.

Russian
Select a font to be used for Russian letters display by default. In the frame on the right you 
can see the word Russian displayed with the selected font.

European
Select a font to be used for European languages letters display by default. In the frame on 
the right you can see European languages names displayed with the selected font.

OK button
Press this button after youve selected fonts.

Cancel button
Press this button to cancel fonts selection. Formerly set fonts will be used.

Help button
Calls the current reference guide page.



Selecting applied fonts
Selecting languages in windows and other properties adjustment
Term window
Explanation window



Tip of the day dialog window
You can look through a set of tips on Dictionary functions usage.

Show tips on startup
If this fields marked, Tip of the day will be showed on Dictionary startup.

OK button
Press this button to close tip window and resume working with Dictionary.

Next button
Press this button to pass over to the next tip.

More button
Press this button to get acquainted with all the tips. Reference guide section containing all 
tips will be shown.

Help button
Calls the current reference guide page.



Search results survey dialog window
also see
You can browse a list of found terms.

Term list
This list contains found terms. Term part that was searched is outlined with color.

Switch button
Press this button to switch over to the selected terms explanation.

Delete button
Press this button to delete the selected term from the list.

Close button
Press this button to close the window. Search results will be removed.

Minimize button
Press this button to minimize the window. Youll be able to open the search results window 
later by selecting Search results item in Search menu.

Help button
Calls the current reference guide page.



Browsing search results



Search dialog window
also see
You can see how many terms were already parsed and how many are still to be parsed, and 
also how many terms were found.

Close button
Press the button to interrupt or pause term search.

Help button
Calls the current reference guide page.



Browsing search results



Search stop dialog window
You can interrupt or resume term search.

Back button
Press this button to abort term search.

Build button
Press this button to look through the list of terms that were found before youve interrupted 
search.

Abort button
Press this button to abort term search or resume working with Dictionary.

Help button
Calls the current reference guide page.



Windows arrangement dialog window
also see
You can arrange open term and explanation windows in accordance with one of the offered 
schemes.

Scheme
Select one of the windows arrangement schemes:
¨ Classic - term windows are set at the top in horizontal tile, and explanation windows 

below in vertical tile (the same way its done in Business&Law Dictionary for DOS);
¨ Mirrored Classic - term windows below in horizontal tile, explanation windows at the top

in vertical tile;
¨ Tile - windows are set so that the whole of them can be seen;
¨ Horizontal Tile - windows are set horizontally so that the whole of them can be seen;
¨ Cascade - windows are set so that all the titles can be seen.

Preserve scheme when opening/closing windows
Mark this item to make term and explanation windows be automatically arranged on 
windows opening/closing.

Sample
You can preview the way windows will be arranged.

OK button
Press this button to arrange term and explanation windows in accordance with the selected 
scheme.

Close button
Press this button to cancel windows arrangement.

Help button
Calls the current reference guide page.



Managing window layout





Main toolbar
also see

Main toolbar is a row of drawn buttons in the upper part of the screen. Toolbar state
depends on the active window.
Toolbar allows to execute many of Dictionary commands by just pressing a button. 
Button functions are briefly described below.

save current explanation to a text file
print current explanation on printer
copy current term or explanation into Clipboard
translate a term out of the Clipboard
term search in all languages
context term search
jump on the next term containing the set context
jump on the previous term containing the set context 
search results lists
return to the previous explanation
pass over to the next explanation
list of term explanations, browsed by references
window properties adjustment
opening a new term window
opening a new explanation window 
turning on/off automatical window arrangement in accordance 
with the selected scheme
selecting Russian language for interface (menus, dialog 
windowsand messages) and reference guide
selecting English language for interface and reference guide
allows to obtain a tip on Dictionary screen elements and menu 
items



Toolbars
Quick tip on toolbar buttons and menu items
Tip on Dictionary screen elements



Term window toolbar
also see

Term window toolbar is a row of drawn buttons in the lower part of the window.
The toolbar allows to lock marker position and select a language quickly. Button 
functions are briefly described below.

install RUSSIAN language in the window
install ENGLISH language in the window
install GERMAN language in the window
install SPANISH language in the window
install FRENCH language in the window
install ITALIAN language in the window
lock marker position in the window



Toolbars
Quick tip on toolbar buttons and menu items
Tip on Dictionary screen elements



Explanation window toolbar
also see

Explanation window toolbar is a row of drawn buttons in the lower part of the 
window.
The toolbar allows to select a language and alignment type quickly. Button 
functions are briefly described below.

install RUSSIAN language in the window
install ENGLISH language in the window
set left explanation text alignment
set right explanation text alignment
center explanation text
justify explanation text



Toolbars
Quick tip on toolbar buttons and menu items
Tip on Dictionary screen elements
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Clipboard
A special Windows memory area, where text and pictures are put for purposes of data 
exchange between programs.



Alignment
The way text in an explanation window is situated relatively to the window borders. Text can
be aligned left or right, centered or justified (aligned both left and right).



Quick menu
A list of most commonly used commands; its called with the right mouse button click.



Window group
A set of linked term and explanation windows: when marker is moved through a term 
window, term translations appear automatically in other term windows, and its explanation -
in explanation windows.



Menu
A bar in the windows upper part that allows to carry out various commands: windows 
opening, searching for term, explanation printing etc.



Term window
A window that contains an alphabetically ordered term list.



Explanation window
A window that contains an explanation of the selected term.



Toolbar
A row of buttons that allow to perform Dictionary commands by just a mouse click.



Context search
A searching method that allows to find context (word or word combination) among terms of 
the current language.



Term search
A searching method that allows to find a term among any of the languages, maintained by 
Dictionary. To perform the search its enough to set terms beginning letters.



Tip of the day
A short recommendation on Dictionary functions usage.



Reference
Word or word combination in an explanation, outlined with color. You can get directly to the 
marked terms explanation by jumping on a reference.



Term
Word or word combination in an explanation, outlined with color. You can get directly to the 
marked terms explanation by jumping on a reference.



Explanation
Detailed elucidation of the terms idea.





Dictionary Tips
         Search  
         Working with windows  
         Clipboard  
         Miscellanious  



Search tips
¨ You can search terms by context (Shift+F7) and by the first word (F7).

¨ You can place the desired term in the Clipboard and then search for it in Dictionary by 
pressing Ctrl+V or Shift+Ins or thru the menu Search|Search Clipboard.



Working with windows tips
¨ In any window you can press right mouse button or Alt+F10 keys and enter the context-

sensitive menu which contains the most often used functions.

¨ You can arrange all windows by pressing Ctrl+A. The scheme how to arrange windows can
be changed thru menu Window|Arrange..

¨ You can arrange windows in the way they are in the DOS version - term windows above, 
explanation windows below by pressing Shift+F5.

¨ In the term window you can change scroll mode from moving marker to scrolling text by 
pressing ScrollLock.

¨ If you hold Shift while jumping on cross-reference or while creating new window thru the 
menu, the new explanation will appear in the separate not linked with active one window 
which can be closed by Ctrl+F4.

¨ You can quickly change language in the window by clicking on the button with the 
appropriate flag on the bar at the bottom of the window.

¨ You can change alignment in the explanation window by pressing Ctrl+L - left, Ctrl+R - 
right, Ctrl+E - center, Ctrl+J - justified.

¨ You can change the language in the window by pressing Left and Right keys while holding 
down Ctrl key. When you press arrow keys, the buttons with the flags are "pressed". When
desired button is "pressed", release Ctrl key.



Clipboard tips
¨ When you are in the term window, you can copy the highlighted term to the Clipboard by 

pressing Ctrl+C or Ctrl+Ins.

¨ While copying term or explanation to Clipboard you can change the way of copying - to 
copy formatting (font, color) or no. To copy accorsing to the preferences press Ctrl+C. To 
copy without preferences press Ctrl+Shift+C.



Miscellanious tips
¨ You can quickly print explanation using currently set printer options by pressing 

Ctrl+Alt+P.

¨ Garant-Service offers you inquiry-retrivial systems on russian legislation.

¨ You can quickly recall Dictionary preferences dialog box thru the context menu on the 
toolbar or on the status line.

¨ To save preferences of Dictionary, choose item Exit from File menu while holding down 
Shift key.






